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1 Description

This product is a fully digital audio processor with integrated MPX stereo encoder and RDS (option).
The audio processor is implemented through a traditional three band limiter. 
This  configuration,  although  simple,  allows  for  a  natural,  well  balanced  sound,  yet  having  a  good
onair presence. 
Audio  processing,  MPX coding  and  RDS  signal  are  all  realized  using   DSPs,  allowing  for  stable
performance over time and extending functionality with firmware upgrades.

1.1 List of changes

1.1.0 17/06/2014 first release
2.0.0 23/09/2014 updated to new firmware 2.0 features
2.0.1 20/11/2014 updated to new firmware 2.1 features
3.0.0 10/03/2015 updated to new firmware 3.0 features
3.1.0 25/01/2016 updated to new firmware 3.1 features
3.2.0 14/09/2016 updated to new firmware 3.2 features
3.2.1 08/03/2021 updated to new firmware 3.2.1 features

1.2 Warnings

Before attempting any operation, please follow the safety instructions contained in the
following paragraph.

The producer declines any liability for damage to people or things due to non-compliance,
even if partial, of the following indications

• Ensure that the supply voltage corresponds to what is indicated on the apparatus.

• Ensure that the electrical system is equipped with a ground connection.

• Use only power sockets and cables with ground connection

• Disconnect power before attempting any operation inside the device.

• The power cutting device is the power cord, so this should be easily accessible and the socket
must be positioned close to the apparatus.

• Any operation involving the access to internal parts must be performed only by trained service
personnel.
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1.3 Front panel

Front panel indicators and rotary knob 

Headphone stereo jack 6,3mm (1/4")

• GATE: Led is on when level is below gate threshold
• CLIP: The analog input level is too high.
• DIG IN: AES/EBU digital input is selected as audio source
• NET: Network audio is selected as audio source(option).

• AGC: Input AGC  gain level 
• MULTIBAND LIMITER: Multiband limiter compression level

Menus navigation and parameter editing is done through the rotary knob.

1.4 Rear panel

Connectors on rear panel 

DIG OUT  (XLR M) AES/EBU output
DIG IN (XLR F) AES/EBU input
LEFT IN (XLR F) Left analog input
RIGHT IN (XLR F) Right analog input
19K OUT (BNC F) 19KHz output for external RDS encoder synchronization. (1Vpp

trapezoidal wave)
MPX OUT (BNC F) Composite MPX output (+6/-6dBm)
SCA IN (BNC F) External SCA / RDS input (will be mixed to MPX output with a gain of -

20dB)
LEFT OUT (XLR M) Left channel analog output
RIGHT OUT (XLR M) Right channel analog output
RS232 (DSUB 9F) RS232 connector
USB DRIVE (USB-A) USB connector for fallback audio on external drive (option)
LAN (RJ45) LAN connector for remote control or streaming audio module (option)
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1.5 Editing and navigation

Menu navigation and parameters editing is done by the front panel knob.
On the main menu which appears after firmware boot, is possible to select the submenu for the
various settings.

Pressing the knob, will enter the selected submenu.

Once entered in the desired sub-menu, if there are adjustable parameters, you can proceed to
editing

Pressing the knob, an asterisk "*" will appear next to the first editable element. This will not happen
if, on the current window, there are no editable parameters.

Turn the knob to position the "*" cursor on the other editable elements of the current window.

If you want now to change the analog input sensitivity, press the knob again. A "<" symbol will
appear next to the parameter to indicate that this is being edited.
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Turning the knob, you now will modify the selected parameter's value.

Once set the desired value, press the knob again. The cursor will switch to "*" again, indicating that
items navigation mode is now active and other items can be selected and edited as described
before.

If editing is however terminated, press the knob again and the "*" cursor will disappear and you can
rotate the knob to navigate to other windows.

Inside any submenu, pressing the knob for more than 3 seconds, will cause a jump to the main
menu.

When pressing the knob for 1 seconds, will appear the Headphone Level regulation.
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2 Front panel display

Following are listed all menus and functionalities available on the current firmware release.

2.1 Audio processor

Into this section are comprised all functions and menus related to the audio processor.

2.1.1 Compression levels

In the window, the compression-limiting levels of the three bands are shown.
The "GTD" label, if visible, indicates that the audio level is below the gate threshold.

2.1.2 AGC

This window contains the settings for automatic gain control (AGC) block, placed at the head of
audio processing chain.
The automatic gain control performs a pre-leveling of the signal applied to the following compressors/
limiters, keeping their working point almost constant.
At the right side of the bar which indicates the level of pre-amplification applied to the input signal, is
placed the AGC status indicator: if "AGC" is displayed, the input level is above the gate threshold
and the AGC and compressors/limiters are operating correctly, if "GTD" is displayed it means that
the input signal is below the minimum level so the compressors release is slowed down and the
AGC slowly decrease its gain down to 0dB.

AGC Status (On / Off): Enables / disables the AGC operation.
Agc Rel.Speed (0..10): AGC release speed. By increasing this value, you will get a faster recover
when audio input gets quieter.
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2.1.3 Loading a preset

The "AIR" field shows the on-air preset name, while, in the "TRY" field, can be specified the name of
a new preset to load. Once selected the desired preset, go on the "COMPARE" label which will  start
to flash.
When "COMPARE" is flashing, pressing the front  panel knob will  cause the "TRY" preset  to go on-
air while the previously on-air preset will go to "TRY", allowing for comparison.

If Source Dep.Presets function was enabled,  it  will  be possible to specify  a different  preset  for each
audio  source   selected  so,  in  this  case,  the  source  for  which  the  current  preset  is  used  will  be
displayed.

It is possible to change the audio source from Audio Input menu.
If  necessary,  make  any  editing  you  want  to  the  factory  preset  (any  preset  starting  with  Fxx)
selected, then save the preset to an user memory (Uxx).
Once saved,  the preset  will  become the audio processing preset  for  the  selected  audio  source,  or
the  general  preset  used  for  all  sources,  depending  on  whether  or  not  the  function  "Source
Dep.Presets" was enabled.
A modified, but not saved, preset will be marked by the "MOD" prefix.  This  preset  will  be overwritten
if a new preset is loaded and then edited.

Mode F00:  BYPASS, has the input  level as  the only editable parameter and this  is  the same both
for the Analog / AES EBU source and NetAudio.
In the case where it  is  necessary to put  have the processor in  bypass  mode  when  any of  the  two
sources  are  selected,  it  will  be  possible  to  compensate  the  differences  in  audio  levels,  if  any,
adjusting their input levels from the audio input menu.
If  one  of  the  sources  is  the  Analog  channel,  we  recommend  to  set  the  input  level  of  the  AD
converter in coarse 6dB steps, then use the bypass input level for fine tuning of Analog source,  then
adjusting the level of the other channel, netaudio or AES EBU, from the audio input menu

2.1.4 Saving a preset

Curr Preset name shows the name of the preset which is actually on air The name can be changed
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following the editing rules described before. When name editing is finished, the "*" cursor will be
positioned to the right side of the name string and will allow to move on the other editable elements
on the window.
Once the preset name has been edited, you can choose an user file to store it, then go to "SAVE"
button which will start to flash. Pressing now the knob will result in saving the preset to the specified
user file.

2.1.5 Gate level and compressor drive

Gate: the gate threshold is the level below which the release time is greatly increased, still allowing
for a slow recovery of the volume but avoiding to amplify any background noise during short breaks.
The indication "GATED" is visible if the input level is below the threshold.
Drive: indicates the compressor/limiter driving level, thus determining the compression level.
A high level of compression will produce a steady and dense sound, while a lower level will result in
a more natural and dynamic sound.
Adjust the drive control to have a compression of approximately 15 dB (which is not critical) as it will
accomodate for most musical genres.
Input  HPF  (ON/OFF):  enables  /  disables  the  30Hz  high  pass  filter  for  infrasonic  component
reduction.

2.1.5.1 Bypass

If the selected process is "F00: BYPASS", the only editable parameter will be the input level and the
bar will indicate the clipping level.
No other parameter is used, so the other editing windows will be hidden.
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2.1.6 Compression level and master release time

Compression: sets the tradeoff between clipping and compression limiting.  
Reducing this value, you will get a louder sound at the expense of more distortion, on the contrary,
raising the compression level will result in a quieter but cleaner sound. 

Release: sets the compessor release time. Shorter times will raise the perceived loudness but
compression artifacts might become evident.

2.1.7 Band link and equalization

BandLink: set the maximum compression difference between bass and middle/highs band.
Setting this value to zero, the bass compression level will be totally independent and this will cause
also a mild auto-equalization.
Setting this value to 100%, it will force the bass compressor to have a gain never greater than the
middle/highs band giving a sound very close to the original.
Brilliance:high band (>6KHz) shelf equalizer.
Presence: 2KHz boost/cut filter.

2.1.8 Bass parametric eq

BassEqFreq: parametric equalizer center frequency
BassEqGain: gain (boost) of parametric equalizer.
BassEq  Q:  Q-factor (bandwidth) of parametric equalizer.
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2.1.9 Bass clipper/limiter

Bass lim thr: bass limiter threshold. Increasing this value will result in a bass band control mainly
done by the clipper. Reducing it, the control will be mainly done by compressor.
Bass lim release:  compressor release time.
The low band release time is adjusted in percentage respect to the master band release time.
A setting of 50%, for example, indicates that the bass band will have a release time equal to half the
time of the medium-highs band.
Shorter release times will increase the presence of low frequencies.
Bass clip Thr:bass clipper threshold. 
Bass clip softness: bass clipper curve selection.
Bass clipper will have a curve progressively softer with increasing value.
A softer curve reduces the distortion introduced by the clipping in contrast, setting to zero
(corresponding to the hardest curve), will produce a bass rich in harmonics.

2.1.10 Stereo expander

In this window is possible to set the stereo expander.
Stereo EXPANDER ON/OFF: the stereo expander is activated (ON) or excluded (OFF)
Level: expansion level. 

Though the stereo expander level is self-limited, we recommend listening to more songs in order to
choose the most appropriate level of expansion.
Exaggerated stereophonic expansion might increase the multipath induced interference.
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2.2 RDS Coder

Into this section are comprised all functions and menus related to the optional RDS encoder.

2.2.1 RDS level and flags

RDS(ON/OFF): sets the coder on and off.
LEV:  RDS subcarrrier level
TP (ON/OFF): sets the TP flag status
TA (ON/OFF): sets the TA flag status
RT (ON/OFF): radiotext enable
MS (MUS/SPC): sets the MUSIC/SPEECH flag status
COMPR (ON/OFF): sets "COMPRESSED" flag status
ARTIFICIAL HEAD (ON/OFF): sets "ARTIFICIAL HEAD" flag status

The "mono/stereo" flag is switched automatically, depending on the MPX modulation type selected.

2.2.2 PI,PTY

PI: PI code setting
PTY: Program Type, settings

Changes will take effect once saved.
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2.2.3 PS and Radiotext monitor

PS MON:  Program Station Name actually on air.
RT MON:  Radiotext actually on air.
If the Radiotext Plus is active for the currently aired Radiotext string, a "+" symbol will be appended
to the "RT" label.

Radiotext Plus, Dynamic PSN and CT (clock  time) functions are available using the supplied
software RD-Link

2.2.4 PS Editor

In this window you can enter and edit PS strings that will be displayed by the receiver, each of which
can be up to 8 characters long.

PS 1..24: selection of the item to edit.
Dur (secs): display time, in seconds, of the currently selected string . A duration of zero,  will  disable
the display of the string.

SAVE: Save the modified item
DEL: delete the selected item

User must save changes before selecting a new string or before exiting the window, otherwise they
will be lost

2.2.5 RT Editor

In this window you can enter and edit RT strings that will be displayed by the receiver,  each of which
can be up to 8 characters long.

RT 1..24: selection of the item to edit.
Dur (mins): display time, in minutes, of the currently selected string . A duration of zero,  will  disable
the display of the string.
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SAVE: Save the modified item
DEL: delete the selected item

User must save changes before selecting a new string or before exiting the window, otherwise they
will be lost

2.2.6 AF list Editor

Alternative frequencies editing window .It is possible to insert up to 25 frequencies  on the first  list  for
the method "A", or 24 lists for method "B". For more details on the differences between the A and B
modes, please refer to the AF List window of programming software.

AfList 1 ... 24: selection of the AF list to be edited.
Freqs: indication of the number of frequencies into the selected list.
Freq #: selection of the frequency number in the list, from 1 to 25, to be edited.
Freq INSERT: Insert  a new frequency in the "Freq #"  position.  The other frequencies  in the list  will
be shifted accordingly.
Freq DELETE: the current frequency will be deleted.
List SAVE: saves the changes
List CLEAR: deletes all frequencies in the current list

Notes:
The list, once modified, will be used only after it  has been saved using the SAVE button.  Selecting
a  different  list  (AfList)  or  exiting  the  editing  window before  saving  the  list,  will  result  in  losing  all
changes.
Any empty  frequencies  (--.-)  eventually  contained  into  the  list,  will  be  deleted  automatically  upon
saving.
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2.3 Audio input setup

In this section are present all controls related to audio sources and  automatic audio fallback

2.3.1 Audio levels monitor and input level setting

In the current window is displayed, with greater accuracy, the input level of the selected channel.

The input level of the selected channel can be adjusted, but the channel will not be put on air.
To change the on air input channel, the following window must be used.

2.3.2 Audio source setup

Audio input: Analog, analog input
Digital, AES/EBU input
NetAudio, streaming audio input.

Analog lev: audio input attenuator level. This adjustment sets the input  level to the A /  D converter.
The nominal level is indicated in the bars:

The initial adjustment  of the input  level should be made so that  the maximum analog  input  level  is
equal to or only slightly above that limit.
In no case the front panel "CLIP" led should light.

Dig. lev: AES/EBU level adjustment
Net lev: streaming module level adjustment.

The adjustment of the individual channels is in 0.1dB steps.
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2.3.3 Audio processor preset selection

If Source Dep.Presets function was enabled, it  will  be possible to choose a different  preset  for each
audio source, which can be selected in the previous menu, otherwise this window will not be visible.
Once selected a preset, it can then be edit into the Audio Processor section.

The loaded preset will be assigned to the audio source currently on air.

2.3.4 Audio fallback setup (audio backup)

The processor can be set to automatically switch to an auxiliary input source if the main input  audio
level is below a minimum threshold.

Fallback (ON/OFF): Enable / Disable automatic audio fallback on backup source.
OnAir: audio source actually on air
I1 - I2 -  I3: Channel list. The channel are listed by  order of priority,  with maximum priority  assigned
to channel 1.
When an high priority channel will become unavailable, it will be replaced by a lower priority  one until
its recovery.
AlmTime: Alarm timeout
Back  Time:  Back  timeout.  It  is  the  time  for  which  the  main  audio  source  must  be   above  the
minimum threshold before it can be set back on air.
AlmThr: minimum audio level threshold

The main audio source is  considered valid If the  level  of  both  channels  L  /  R  are  above  the  alarm
threshold.  If  a  single  channel  is  less  than  the  alarm  threshold  for  a  period  longer  than  the  alarm
timeout, the backup source will be put on air.
When the main audio source will  recover,  once elapsed the "Back Timeout",  it  will  be put  back  on
air.

Changes will be applied upon exiting the menu.
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2.4 Audio output setup

This section contains the settings relating to the DIG OUT - L R OUT audio outputs.

2.4.1 Audio output regulation

ANA LR Out : audio output level on rear XLR Left-Right OUT connector.
DIG LR Out : output audio level on rear XLR DIG OUT connector 
Out deemph: output audio deemphasis. This is related only to the audio output, not to MPX output.
Out pos: point of acquisition of the output signal, it can be selected form:

Post clip&flt: output signal is taken after clipper and lowpass filter.
Pre filter: output signal is taken prior the lowpass filter, but after the clipper.
Pre clipper: output signal is taken before the clipper.

2.5 MPX output setup

2.5.1 MPX modulation and pilot subcarrier setup

Modulation (stereo, mono l+r, mono L, mono R):
Stereo: stereo modulation
Mono L+R: monoaural modulation from L+R channels sum.
Mono L, Mono R:monoaural modulation from a single channel.

Preemphasis:  50/75uS  preemphasis,  it  should  be  set  according  to  local  FM  broadcasting
standards.
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Pilot level:  19KHz pilot tone injection level.
Pilot Phase: pilot tone phase adjustment.

2.5.2 Output level setup

Audio level: percentage of audio signal (L+R, L-R) into the composite MPX signal.
In case of monoaural broadcasting, without RDS and pilot  subcarrier,  this  level can be left  at  100%,
and this will produce a deviation of 75KHz.
In  all  other  cases  it  should  be  reduced  according  to  the  level  of  injection  of  the  two  subcarriers,
otherwise overmodulation will occur.
For example, if a RDS subcarrier of 2KHz and a pilot tone of 6KHz are desired, the audio signal level
can not be greater than

100*(1- ((PilotCarrierDeviation+RDSCarrierDeviation)/75))
which, for the example described above, will correspond to:
100*(1- ((6+2)/75))=89.3% 

Composite level: MPX output level. 
Test  tone  (!):  when  activated,  will  put  on  air  a  400Hz  tone,  having  an  amplitude  equal  to  100%
modulation.
If RDS and pilot subcarriers were correctly set, the final modulation will not go above this limit.
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2.6 System setup

2.6.1 Display, Source Dependent Presets, Device ID

Contrast: display contrast adjustment.
Source Dep.Presets: enable/disable audio preset selection depending on audio source.

ON: if the function is enabled, a different audio processing preset can be specified for each
audio source.

OFF:if the function is disabled, the same preset will be used for all audio sources.

ID: device identifier. It is a 16 characters long label which will be shown in the main menu screen,
useful for identification when multiple devices are installed.

2.6.2 GPI and MPX changeover option (Split)

In this menu it is possible to remotely select the channel to be broadcast or manage an MPX
advertising split in output (option). The election is possible via GPI, serial and Network card.

GPI status: status of the 8 available ports, from 7 to 0.

Split ctrl port: enable the function and select the communication mode.
OFF: disabled function.
GPI: active function on CTRL port.
Serial: active function on RS-232 port.
Network: active function on Ethernet port.

Invert split status: invert commutation MPX Input set on GPI mode
OFF: without command it is set in [NETWORK] mode.
ON: without command it is set in [SPLITTING] mode.

The split status is shown at the top of the display.
In [SPLITTING] mode, in MPX output there is the processed signal coming from Analog or Digital
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Inputs or Net Ip stream (if present).
In [NETWORK] mode, in MPX output, the signal applied to MPX IN is present.

Rear Connectro GPI (CTRL)

GPI port status:
0: Pin 6 - Set ANALOG Input
1: Pin 2 - Set DIGITAL Input
2: Pin 7 - Set NET/IP Input
3: Pin 3 - Set MPX Input (SPLIT)
4: Pin 8 - Not used
5: Pin 4 - Not used
6: Pin 9 - Not used
7: Pin 5 - Not used

The inputs  are activated by  grounding the relative pin or by  providing a voltage from 5 to 12VDC, in
this case the jumpers placed on the board inside the device will have to be moved from the "CLOSE"
to "VIN" position.
The selection of the channels  through the GPI port  takes  place  with  exclusive  priority  on  a  single
channel, if more inputs  are activated at  the same time the channel is  restored before the selection,
only the MPX channel has absolute priority  and at  each activation it  does not  take into account  the
status of the other 3 inputs by bringing the MPX IN signal to MPX OUT.

Example 1: the Analog channel is on the air,  pin 2 is  activated by  broadcasting the Digital channel,
at the same time pin 7 NET / IP is also activated, since the selection of two channels  is  not  valid at
the same time, the channel returns to air Analog.
Example 2: the Digital channel is on the air,  pin 6 is  activated by  broadcasting the Analog channel,
at the same time the MPX pin 3 is activated,  the analog channel remains active but  the MPX output
is switched to MPX IN.

Network command by lan:
By selecting Network  on "Split  ctrl  port"  commands  can  be  sent  via  LAN using  the  UDP  protocol
with standard ethernet card, the TCP protocol with IP Streaming option card.

[AB010103] select analog input
[AB010200] select digital input
[AB010301] select NET/IP input
[AB010406] / [AA010001] select MPX input
[AB010002] o [AA010100] return on main channel

The  selection  command  must  be  repeated  continuously  otherwise  the  device  re-enters  the  main
channel.
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2.6.3 PassCode Setup

User  Password:  in  this  section  the  user  can  enter  a  numeric  password  that  will  be  required  for
accessing the device. Setting "0000" (default value) will disable the password prompt.
Autologout (mins):  Automatic lock timeout. If no action is  done on the front  panel knob within the
specified  time  interval,  the  device  will  enter  into  lock  state  and  the  user  will  need  to  re-enter  the
password to log in again.
LOGOUT: immediate logout and lock.
SAVE: Saves any changes made to the numeric  password or the duration  of  the  automatic  logout
timing.

2.6.4 Ethernet setup

IP: current ip address
GWY: gateway address 
Port: UDP port number
NetMask: netmask in CIDR notation.
APPLY:  apply and save changes.

This page is visible only if the network  module is installed.

2.6.5 System info

Sys: operating firmware release
Proc: audio processor and MPX coder firmware release
Hw: hardware release
BL: MCU bootloader release
SN: serial number
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2.6.6 Options

In this window the user must enter the code to enable the optional features. 
Once entered the code for the desired option, go to the "ENTER" button and, when it  will  flash,  push
the front panel encoder.
The device will verify the code and, if found correct,  will activate the requested option.

Example for RDS coder:

2.6.7 Login window

To protect the device from unauthorized operation, a security code can be enabled by  accessing the
System menu, Set password.
When  the  device  is  turned  on  (or  the  auto  logout  time  is  elapsed),  the  login  page  will  be  shown
where the pass code is to be entered.

LOGIN: when the correct pass code is entered, will log in user.

Pass code  lost  or  forgotten:  after  the  20th  unsuccessful  login  attempt,  an  unlock  code  will  be
displayed.Call customer service and tell this code in order to get back your pass code.



26 D-PRO-3FM Audio Processor

© 2021 BEI Electronics LLC

2.7 Headphones Level

The headphone level can be adjusted using the front panel knob.
Pressing the knob for more than 1 second, will show the adjustment level menù.

After 3 seconds the level menù will close automatically.



Section 3Programmming software
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3 Programmming software

A PC based softwareProcessor Programmer, compatible with 32 and 64 bits  Windows Xp,  Windows
7, Windows 8.X, Windows 10, is provided for processor remote control and setup.

Connection is done through:
serial port 9600 baud 8N1
ethernet port TCP-IP (if optional streaming module is installed)
ethernet port UDP

3.1 Main window

In the main window the type of connection can be selected,  via COM port  or through Ethernet  port
using TCP-IP (needs streaming module) or UDP (needs ethernet  module).  Once the communication
mode  is  set  up  and  the  processor  connected,  press  "Connect".  If  communication  is  correct,  the
program will read all internal settings and device information.
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3.2 Processor Params

This section contains the audio process controls and presets, setting of the audio input and output
sources and system parameters.

3.2.1 Processor Presets

On this  page are shown the input  levels,  the  audio  input  currently  on  air,  the  presets  list  and  the
audio processing parameters.

All presets are listed and, with a double click, is possible to recall a preset and put it on air. 
Factory presets are displayed in blue background,  user definable presets  in green and,  in orange,  a
modified preset not yet saved.
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The modified preset (in orange) will be usable until a new preset is loaded and then modified.

On the same page are present  the audio processing parameters.  For a detailed description of each
parameter, please refer to the audio processor section:
Processor Drive, Gate Level
AGC Enabled, AGC Speed
Compression, Master Release
Band Link, Brillance, Presence
Bass Lim Thr, Bass Lim Presence, Bass Clip Threshold, Bass Clip Softness
Bass EQ, Bass EQ Q, Bass EQ Freq
Expander Level, Stereo Expander Enabled

Read: read the parameters setup from the processor
Update: send the modified audio processing parameters  to the processor:  when a factory  or a user
preset  is  modified,  a temporary  preset  will  be  created.  The  Save  Onair  button  will  be  enabled  to
save  the  preset  once  changes  are  terminated.  The  preset  name  can  be  directly  changed  in  the
preset name editor.

Then,pressing the Save OnAir button, it will be possible to select the destination user preset.
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3.2.2 Audio input-output

This page allows for selection of on air audio input, changing audio output parameters, setting up the
audio fallback and the source dependent presets.

For a detailed description of the following parameters, please refer to  audio input setup, audio output
setupand source dependent presets

Audio Input, Analog InputLevel, Digital InputLevel, Network InputLevel
Bypass InputLevel
Audio OutputLevel
Audio Backup Enalbled
Source dependents presets

Input 30Hz HPF: enables / disables the 30Hz high pass filter for infrasonic component reduction.

Read: read parameters from the processor
Update: send changes to the processor
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3.2.3 System setup

In  this  page  it  is  possible  to  enable  and  adjust  the  optional  RDS  encoder  carrier  level,  the  pilot
carrier, insert and adjust the network parameters.

The network  parameters  are related to the  optional  network  module  only.  If  the  streaming  module
was installed, network  configuration will be done through the web server of the module.

For a detailed description of the following pararmeters, please refer to MPX output setup and System
setup

RDS  Enabled,  RDS  level,  Pilot  Level,  Pilot  Phase,  Modulation,  Preemphasis,  MPX Output  Level,
MPX Audio Level
NET IP, NET MASK, NET GATEWAY, NET PORT

Read: read parameters from the processor
Update: send changes to the processor
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3.3 Loading and saving a preset

All the audio presets customized by the user can be saved in files,  this  preset  can be transferred to
another DPRO or saved in an external drive.
The  remote  control  software  allows  to  load  and  save  the  audio  processing  presets  through  the
File>Processor menu:

Save Usr Presets to Disk

the on air preset will be saved to disk.

Load Usr Presets to Onair

the preset loaded will be put on air.
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3.4 Loading and saving system

The remote control software allows to load and save the system configuration through the "System"
menu, and this includes all parameters listed under  "System"  and "Audio Input-Output" tabs.

Save System config to Disk

the system configurationi will be saved to disk.

Load System config from Disk

the system config preset loaded in.
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3.5 RDS

RDS configuration pages will be visible only if the optional RDS coder was enabled.

3.5.1 RDS Flags window

This window contains the configuration parameters of the RDS encoder.

RDS ENABLED: enable RDS coder.

PTY: Program Type
Set the program type.
Many receivers  are equipped to select  the  received  stations  based  on  the  format  preferred  by  the
listener. 

PI:Program Identification
Identification code of the station.
The code consists of 4 digits, the first digit indicates the country of origin, the second represents  the
area of coverage and the last two identify the station into its coverage area.

First digit, the country of origin of the program. You may write it directly into the “PI Code” editbox or
select it using the “Country” dropdown list.
A list of some country codes is reported in appendix A.

For the second, according to the coverage area, choose one of the following codes:

0 local coverage, the station is supposed to have one frequency only

1 International coverage

2 National coverage
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3 Supra-regional coverage

4..F area codes for regional coverage stations

Note:  the local coverage code “0” is  intended for stations having one frequency only,  so  its  use  is
intended  just  in  this  case.  If  the  station  has  more  than  one  frequency,  a  supra  regional  (3)  or
regional code (4 to  F)  must  be  used.Using  the  local  coverage  code  (0),  make  many receivers  to
ignore the alternative frequencies tables.

The two last digits uniquely identify the station into its  coverage area and shall be different  amongst
all other stations broadcasting over the same area.

Some examples:

5001: Italian radio station (5) local coverage (0), program identifier code 01
5202: Italian radio station (5) national coverage (2), program identifier code 02
54AF: Italian radio station (5) regional coverage (4), program identifier code AF

TP: Traffic program
This flag indicates that your station, during normal programming, broadcasts traffic programs.

TA: Traffic Annonunce
Traffic Announce on air.
This flag should be set when traffic related news are being broadcasted.
For this reason, the TA flag can be switched by the external control port.

MUSIC: This flag indicates if the station main format is music or speech.
Some  receivers  use  this  information  to  apply  a  different  tone  equalization  or  volume  according  to
whether music or speech is being broadcasted.
It is possible to switch this flag externally, using the external control port.

ARTIFICIAL HEAD:This flag indicates that the program was recorded using an artificial head.
This  device is  a dummy human head with two microphones inserted into the auditory  canals,  used
during the recording process of the  performance  or  live  event,  to  accurately  reproduce  the  original
spatiality.

COMPRESSED: This flag indicates that the program was compressed.

ENABLE RADIOTEXT:Flag to enable radiotext group (2A) transmission.
If disabled, only 0A groups will be trasmitted.

STATION ID:This 16-chars string can be assigned to the coder for its identification.
It could be its destination, the site to which the encoder is  assigned,  or the name of the radio which
owns it.
It  will  not  be  shown  anywhere  else,  neither  transmitted  into  any  RDS  block;  it  is  only  a  label  to
identify the processor.
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3.5.2 PS window

In this  window,  It  is  possible  to  enter  the  program  station  names,  each  of  which  can  be  up  to  8
characters long.
For each string you can set the display duration time in seconds.
A duration time of 0, disables the corresponding string.

READ: read all PS  strings from the encoder.
Warning: all strings on the grid will be overwritten.

WRITE:transfer all strings on grid to the coder.
Warning: the strings on the coder will be overwritten.

WRITE MODIFIED:transfer only modified entries

CLEAR ALL:clear all strings which are on the grid.

CLEAR SELECTED:clear all selected strings on the grid.



38 D-PRO-3FM Audio Processor

© 2021 BEI Electronics LLC

3.5.3 Radiotext window

In this window, It is possible to enter the radiotext strings, each of which can be up to 64 characters
long.
For each string you can set the display duration time in minutes.
A duration time of 0, disables the corresponding string.

READ: read all radiotext strings from the encoder.
Warning: all strings on the grid will be overwritten.

WRITE:transfer all strings on grid to the coder.
Warning: the strings on the coder will be overwritten.

WRITE MODIFIED:transfer only modified Radiotext entries

CLEAR ALL:clear all strings which are on the grid.

CLEAR SELECTED:clear all selected strings on the grid.
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3.5.4 AF Lists window

The RDS encoder allows for method "A" or "B" for alternative frequencies coding.
The choice between the two methods depends on the structure of the network and the number of
alternative frequencies.
There is no flag which indicates if the alternative frequencies are transmitted by method "A" or "B":
the difference between the two methods is encoded in the way the frequencies are disposed into the
list.

Notes:
It is not possible to compile different lists using the A and B simultaneously.
“A” method should be used only when the network  has a maximum of 25 frequencies and does not
differentiate regional programming.
“B” method is used when the alternative frequencies are more than 25 or when, within the same
network , there is a program differentiation, such as local news or advertising, only on certain
frequencies.
The lists must be compiled starting from the first and should be filled leaving no empty lists in
between: any empty list will be automatically removed upon coder programming.
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3.5.4.1 Editing

The frequencies must be inserted starting from the first list “Af list 1”, cell AF1.

Right-clicking on the list, a popup menu will appear allowing to:

Clear list: the current list will be cleared
Sort frequencies: the frequencies inserted into the current list will be sorted in ascending order
Insert: insert a new frequency at the selected cell position
Remove: remove the frequency at the selected cell position
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3.5.4.2 A Method

This is the simplest method and it is indicated for all those stations which have a maximum of 25
alternative frequencies and do not provide regional - differentiated programming.

To implement this method, simply insert in AF List 1 all frequencies of the station in ascending
order.
No other list must be filled.

Example:
88.1
91.3
104.1
104.5

3.5.4.3 B Method

This method is used where the number of alternative frequencies used in a network exceeds 25, or
where it is required to indicate frequencies which belong to different areas which at times carry
different programs.
Each transmitter and associated repeater stations broadcast the same set of different AF lists in
sequence.  
The number of AF lists within a network is in general identical to the number of transmitters and
repeater stations in the network so as to provide a unique list for each transmitting station.  In this
protocol the alternative frequencies for the VHF/FM transmitters are individually addressed by
transmitting the tuning frequency paired with one alternative frequency within one block.
Each list starts with the tuning frequency for which the list is valid.
All remaining pairs (up to 12) give the tuning frequency together with a valid AF.
Usually, the tuning/AF pair has  to be entered in ascending order if the AF is not a regional variant of
the tuning frequency, on the contrary the order has to be reversed.
If the number of AFs of a station is larger than 12, the list must be split into two or more lists.  These
lists are transmitted directly one after the other, and the receiver must combine the lists again.
If a transmitter frequency is used more than once within a network the respective AF lists are
transmitted separately.  In order to indicate that these lists with the same tuning frequency belong to
different stations, the lists must be separated by AF lists of other stations. 

To simplify the programming of a B list, put into the first line AF1 the main tuning frequency, then
enter on the other lines (AF2 to AF13) a maximum of 12 alternative frequencies, then press the
button "Build B list."
If you, in future, wish to add some new frequencies to the list, simply enter them at the bottom and
press the button "Build B list again."
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I

The main frequency (90.0MHz) is put in the first  AF cell  (AF1) and all  alternatives  are following from
AF2 to AF6. 

Right  click  on the list  and  select  the  “Build  B  List”  command:  the  list  will  be  compiled  using  "B"
method.
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3.5.5 Loading and saving RDS coder configuration

The remote control software allows to save and reload a complete RDS coder configuration through
the File>RDS menu:

Load Configuration

Save Configuration

The *.rds file will contain the whole RDS encoder configuration, it can be stored as a backup or used
to transfer the configuration to other devices.
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3.6 Passcode setup

To protect  the device from unauthorized operation,  a security  code can be set.  The default  code  is
0000 (security disabled), but it can be changed through the following procedure:

Put the current Passcode into the PassCode edit box (0000 by default).
Put a new code into the "New Code" and, the same again, into the "New Code Confirm" editor. 
Go to Menu->PassCode->Change Passcode

The user will be prompted for passcode change confirmation, then the passcode will be changed.

Store Password to disk: store the current passcode to not enter it each time the program is used.



Section 4RD Link



46 D-PRO-3FM Audio Processor

© 2021 BEI Electronics LLC

4 RD Link

RD-Link is a software which allows the connection of the RDS coder to the radio automation system
to allow for dynamic radiotext and radiotext Plus, TA and Clock-Time to be implemented.
At  the  time  of  writing  this  document,  the  software  is  already  compatible  with  several  radio
automation systems,  but  other interfaces may be included on customer request  in order  to  extend
the compatibility to other systems.

4.1 Radiotext Plus

Radio text  plus  is  a complementary  service  that,  united  with  classic  radiotext,  enables  tagging  of
specific radiotext parts so that they can be isolated and used by some specialized receivers.
You can then, for example, have the complete station playlist aired for the listening period.

An example of normal radiotext tagged with radiotext plus (RT+).

The normal radiotext carries the string: "SHAKIRA - La tortura"
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A receiver with Radiotext Plus decoding capabilities will "know", for example, which part of the whole
text is the artist's name and which is the song title.

In this case, the song title and artist's name are used to compile the playlist  aired by  the station we
are listening.

In the case below, the radiotext string is "You are listening to Shakira with La tortura Feat.  Alejandro
Sanz" and both normal radiotext  and tagged radiotext  are shown: first  string is  the artist  name, the
second is the song title, last string is the normal radiotext.
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4.2 Monitor

On the  Monitor window the dynamic PS and Radiotext strings are shown in the same way as  they
are being transmitted.
It is shown also the status of TA,CT, RT+ flags and scheduler.

TA Orange : TA flag active during traffic news on air.
Gray: TA flag disabled

CT Green: transmission of Clock/Time block 4A, for remote clock visualization and 
synchronization, is enabled 
Gray: CT is disabled.
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RT+ Blue: the radiotext string actually shown is tagged using radiotext plus.
Gray: Radiotext Plus is disabled.

SCHED Green:scheduler is enabled, Radiotext Plus is enabled
Red:scheduler is enabled, but actually Radiotext Plus is 
disabled by the scheduler
Gray: scheduler disabled, Radiotext plus tagging is controlled 
by the flag Enable RT 
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4.3 Configuration

Open configuration menu (Tools->Configuration), and the following window will appear:

4.3.1 Setup

4.3.1.1 Program ID

It  is  possible  to  assign  a  name  to  the  executable  window in  order  to  recognize  it  quickly,  when
multiple executables are running at  the same time to control different  coders  (eg different  programs
belonging to the same publishing group).

4.3.1.2 Radiotext Plus and dynamic PSN

Enable RT +: Enable radiotext plus
The strings sent by radio automation system will  be passed to radiotext  only  if this  flag is  enabled.
You can also add a prefix and a separator to the string which will be put on-air.
Please note that the maximum length of radiotext string in block 2A, is 64 characters.
If the total length of the string,  including prefix  and separator,  will  be longer than this  limit,  it  will  be
truncated automatically.

Send RT + titles to PSN: Enable sending radiotext titles on PSN.
With this function, the song titles will also be sent on the PSN (maximum length is 8 characters ).
This function should be used with caution as it can cause driver distraction and in some countries  is
expressly prohibited. You are advised to check your local regulations before to activate it.
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To limit driver distraction, single character scrolling has been reduced to a minimum, as  the program
tries to convey mainly whole 8 characters blocks.

Separator: separator to be inserted  between  title  and  artist.  A  different  separator  can  be  chosen
with respect the one used for radio text.

Scroll interval (secs): scroll time interval of a single character.
All strings which will not fit 8 characters, will be displayed by scrolling one character at  a time using
this interval.

Word interval (secs): display time of a single word.
A word which has a length less than or equal to 8 characters, will be displayed for the time selected.

Repeat delay (secs): The title will  be displayed again on the PSN ,  after this  time (in seconds) is
elapsed. If the entered value is  0,  the title will  be displayed once at  the beginning of the new song,
then the coder will send the PSN strings stored internally until the next song.

End title blank duration (secs): if set to any value other than 0, an empty PSN will be displayed for
the selected duration, once the dynamic PSN is ended and before to putting on-air the internal PSN
strings.

Sync start DyPSN: if enabled, it  will  start  the dynamic  PSN only  at  the end of the internally  stored
strings.
Eg internally stored strings are:"MY RADIO", "THE BEST", "IN TOWN" (loop).
Without  Sync  Start:  "MY  RADIO",  "BEATLES",  "HELP","THE  BEST","IN  TOWN","MY  RADIO",
"THE BEST", "IN TOWN"(loop) (dynamic PS strings are bolded).
With  Sync  Start:  "MY  RADIO","THE  BEST","IN  TOWN","BEATLES",  "HELP","MY  RADIO","THE
BEST","IN TOWN"(loop) (dynamic PS strings are bolded).

Restart  from  first  PSN item  after  DyPs:  if  enabled,  after  a  dynamic  PSN is  transmitted,  it  will
restart the display of internal strings from the beginning.
Eg internally stored strings are:"MY RADIO", "THE BEST", "IN TOWN" (loop).
Without restarting: "MY RADIO", "BEATLES", "HELP","THE BEST","IN TOWN","MY RADIO", "THE
BEST", "IN TOWN"(loop) (dynamic PS strings are bolded).
With restarting::  "MY RADIO",  "BEATLES",  "HELP","MY RADIO",  "THE BEST",  "IN  TOWN"(loop)
(dynamic PS strings are bolded).

4.3.1.3 TA - Clock time

Enable TA: the TA flag will be switched on during traffic news.

Max  duration:  maximum  traffic  news  duration.  Once  this  time  is  elapsed,  the  TA  flag,  if  it  was
previously set on, will be automatically switched off.

TA Trigger string: it is the name, as passed to the program by the radio autiomation system, of the
traffic news audio file.  If traffic  news are live,  this  could be the name of the file used as  traffic  news
liner. The name is case insensitive.

Hide traffic title string on radiotext: if enabled, it will not send the string associated with the traffic
news file to radiotext or PSN.

Enable CT: enable sending CT (clock time). 
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Enabling this function,  it  will  be sent  the 4A block  for radio alarm clocks synchronization and date-
time visualization.
As the PC system clock  will  be used,  it  is  recommended to keep the  system  clock  synchronized
using any time server.
The 4A block  transmission will be suspended when PC is  shut  off  or the PC-Coder communication
is broken.

Add offset: offset for the time currently sent.

4.3.1.4 Communication interface and additional settings

Max RT Duration: maximum radiotext duration.
This control sets the maximum time for the same Radiotext Plus string visualization.  If this  period is
exceeded,  the coder  will  start  to  send  the  internally  stored  RT strings,  returning  to  dynamic  RT+
once a new string is received. 

Show log: show program activity log.

Center PSN: auto center the strings displayed on PSN, if they are shorter than 8 characters.

Use  scheduler  for  dynamic  contents:  enable  scheduler  for  dynamic  radiotext  plus  and  PSN
activation, if they are supposed to be active only on some week days or at a specified time,

Create  a  copy  of  RDS  file:  creates  an  identical  copy  of  the  title  file  written  by  the  automation
system to be read by other applications (eg: streaming encoder).

Save log: save a daily program activity log on a file eg: "log_18-06-2014.txt"

Coder interface: communication interface selection, RS232, TCP/IP or UDP.
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4.3.2 Raw Text Importer

Raw text importer allows to read plain text files generated by the radio automation system.

The contents  of the  currently  selected  file  (from  the  main  window menu  File->  Raw  TextFile)  is
displayed in the Raw Text Input.

The artist and title fields may be separated in two ways:

using separators: the strings read from the file will  be divided using the characters  entered  in  the
"Separators" editor.
In the above example, the input string  "SHAKIRA;La tortura" is divided, using the separator ";".
This will produce two output lines (line 0:La tortura, line 1: SHAKIRA).
Then, using the controls "Artist item" and "Title item", set which line must be used as title and which
one as the artist name.

using  identifiers eventually  included  in  the  raw  file:  if  the  raw file  was  already  marked  with
labels such as:
CurrArtist = Michael Jackson
CurrTitle = Thriller
you can simply  enter in the  editors  "Artist  ID"  and  "Title  ID"  the  two  identifiers  "CurrArtist  ="  and
"CurrTitle =" (without quotes).
The program will then automatically isolate strings related to artist name and song title.
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In both cases, pressing the "Test"  button,  the user will  be able to experiment  with different  settings
of indexes, separators or identifiers.

If the checkbox "Ignore if artist or title are null" is checked, all items having no artist name or title will
be discarded.
This  feature,  combined  with  the  word  filter,  avoids  to  display  jingles  titles,  back ing  tracks  and
everything else that must not appear in the dynamic radiotext.

4.3.3 Word filter

Word filter  avoids  the  visualization,  on  dynamic  radiotext  and  PS,  of  all  strings  which  match  any
word in list.

Words are added writing them in the editing line,  then must  be set  the recognition  method  (Whole
Word or Any Occurrence). Pressing the "Add" button, the new word will be added to the list.

Whole word: the word to be recognized must be correspond exactly to the input string:
Example, filter word  "apple": "apple" is recognized and filtered, "pineapple" is not recognized.
Any Occurrence: any occurrence of the filter word is recognized:
Example,  filter  word   "wide":  "wide"  is  recognized  and  filtered,  but  also  "widescreen"  or
"worldwide".

Words are  always  compared  in  case-insensitive  mode:  setting  a  filter  for  word  "Test",  "TEST"  or
"TeSt", will result in the same effect.
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4.4 Scheduler

The dynamic  content  scheduler  (menu Tools->Scheduler)  allows  to  activate  the  Radiotext  Plus
and dynamic PSN only in predetermined time intervals.

For example,  we  want  to  use  dynamic  RT+  and  PSN only  from  8.00  to  12.00  and  from  18.00  to
23.00 every day except on Sundays where it will be active for the entire day.
So an event must be created, scheduled for 8:00 am (set into "Start Time" box),  having "Enabled"
status checked .
Pressing the "Add" the button, the event will be added to the events list.

We have that the dynamic content will be disabled from 00.00 to 8.00 then, for the event  we created,
from 8.00 onwards it will be enabled.
Now the  dynamic  content  disabling  event  should  be  added:  put  12:00  into  the  "StartTime"  box,
unckeck the "Enabled" checkbox and push "Add" button.
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The dynamic  content  has to  be  re-enabled  from  18:00  to  23:00,  so  one  enabling  event  has  to  be
added at 18:00 and a disabling event at 23:00.
In the following picture is represented the complete programming.

Summarizing: firstly the dynamic  content  enabling was added at  8:00hr,  then the disabling event  at
12:00hr, the re-enabling at 18:00hr and the disabling at 23:00hr.
Since this  scheduling will  be the same for almost  the whole week,  it  can  be  simply  copied  to  the
other days, pressing the "Same for all days" button.
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Once copied, it can be verified that, changing the week day selection at  the top of the window,  the
scheduling is the same for all days.
Done  this,  you  will  then  modify  the  sunday  scheduling  only,  where  the  dynamic  content  will  be
enabled for the whole day.

Select the week day, on the top of the window, "Sun"

Press the "Clear button" to delete all scheduler entries for the current day.
Once all  entries  have been deleted,  just  add an event  starting at  00:00,  with  "Enabled"  checkbox
checked to enable the dynamic content .
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Programming is completed. Press "OK" button to save and exit from the current window.

Follows a short description of the other controls on the window:

Remove: removes the currently selected entry
Update: updates the currently selected entry with new time and/or status informations.
Clear all schedules: deletes all entries over all days.



Section 5Streaming audio module
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5 Streaming audio module

The  module  adds  audio  streaming  decoding  or  encoding  capabilities  for  receiving  or  trasmitting
streaming HLS / MP3 / AAC + shoutcast servers by HTTP/HTTPS using   TCP / IP connectivity. 
The audio output is transferred in digital format to audio processor / stereo encoder, thus achieving
the highest audio quality.

5.1 Decoder audio Stream

Connect the apparatus to your LAN and turn it on. Open a web browser on a PC from which the
apparatus can be reached and type on the web browser's address bar: http://192.168.1.100.
The audio module internal webserver should then load the login default page.

No password set by default, click on the login button and enter the main page.

Go to the "Streaming settings" menu and set one or more URLs from which to receive the audio
stream.
Save current configuration by pressing the "Apply settings" button.



61Streaming audio module

© 2021 BEI Electronics LLC

The module adds audio streaming decoding capabilities for receiving streaming MP3 / AAC + / HLS
shoutcast servers or by using TCP / IP connectivity. 
The audio output is transferred in digital format to audio processor / stereo encoder, thus achieving
the highest audio quality.
An helpful guide for all settings appears on the side of the configuration page.

On the audio processor, now select the audio input "NetAudio" and the streaming audio received by
the module should be put on-air.

Adjust, if necessary, the input level of audio input "netaudio." If you intend to use any audio
processing during streaming audio playback, this setting can also be omitted since the processor
will provide for automatic leveling.
The preset for the network input can be chosen into the next window, after "netaudio" input has been
selected into the current.

If you want to use more than a single audio source, for using the integrated automatic audio fallback,
proceed to its selection and its associated audio processing preset.

Finally, turn the audio fallback on.

5.2 Encoder audio Sream

The  audio  streaming  encoder  module  has  the  task  of  generating  a  streaming  stream  in  the  IP
network,  various encoding formats  allow the transmission of the  audio  generated  by  the  processor
over the network  to shoutcast  /  icecast  servers,  even in low latency,  using RTP, UDP, Multicast  or
TCP / IP connectivity.

AvailableCodec:
MP3 fino a 320kbps, (VBR e CBR), 
PCM 16bit @8, 16, 22.05, 24, 32, 44.1, 48 kHz
G.711, uLaw, aLaw
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An helpful guide for all settings appears on the side of the configuration page.

5.3 Quick setup

The default IP address is 192.168.1.100.
If the IP is unknown, connect the the processor directly to a PC network  card, then use the supplied
utility "module_finder.exe" to recover its IP address.

Connect the apparatus to your LAN and turn it on. Open a web browser on a PC from which the
apparatus can be reached and type on the web browser's address bar: http://192.168.1.100.
The audio module internal webserver should then load the default page.
Go to the "CONFIG" menu and set one or more URLs from which to receive the audio stream.
Save current configuration by pressing the "SAVE & REBOOT" button, wait for the restart of the
module.

Configure the network settings of the module: SETUP -> NETWORK
Save by pressing the "SAVE & REBOOT" button, wait for the restart of the module.
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